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ABSTRACT 

A large number of sanitation workers die every year due to erratic and lack of facilities 

available, and harmful toxic gases released while cleaning the sewage. Real time 

health monitoring systems for such workers will prove helpful. This real time health 

monitoring device will work in a sewage as a safety equipment. In this paper, the 

device presented will monitor the pulse rate of a person using a pulse oximetry sensor, 

the methane concentration and the atmospheric oxygen concentration and provide 

alert to worker and exterior unit. when parameters deviate from the safe range. This 

parameters in real time will promptly alert the workers to stay safe and detect toxic 

gases before any harm. The Smart Safety Monitoring System for Sewage Workers 

with Two-Way Communication is designed to improve the safety and well-being of 

sewage workers. Sewage workers face numerous health and safety risks while 

working in confined and hazardous environments. 

The proposed system integrates wearable technology, environmental sensors, 

and real-time communication to ensure the safety of sewage workers. The system 

consists of a wearable device, environmental sensors, a communication module, and 

a control center. The wearable device monitors the worker's vital signs, such as heart 

rate, blood oxygen level, and body temperature. Environmental sensors monitor 

environmental conditions, such as gas levels, temperature, and humidity. The 

communication module transmits data from the wearable device and environmental 

sensors to the control center. The control center receives and analyzes the data, 

sending alerts and notifications to the worker's wearable device and emergency 

services in case of an emergency. The system enables real-time two-way 

communication between the worker and the control center, allowing for prompt 

response to emergencies and ensuring the worker's safety. The proposed system offers 

numerous benefits, including improved safety, increased efficiency, and reduced 

costs. Enhanced monitoring of worker vital signs and environmental conditions 

reduces the risk of accidents and injuries. 

Real-time communication and automated data analysis optimize work processes 

and reduce response times. Minimized risk of accidents and injuries reduces costs 

associated with medical treatment and lost productivity. The system is designed to be 

scalable, flexible, and adaptable to different sewage systems and worker requirements. 
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CHAPTER 1 

INTRODUCTION 

The project aims to design and develop a smart safety monitoring system for sewage 

workers that integrates wearable devices, environmental sensors, and a two-way 

communication system. The system will provide real-time monitoring of workers' vital 

signs, location, and environmental conditions, enabling prompt response to 

emergencies and improved decision-making. Design and develop a smart safety 

monitoring system for sewage workers. Integrate wearable devices, environmental 

sensors, and a two-way communication system. Provide real-time monitoring of 

workers' vital signs, location, and environmental conditions. Enable prompt response to 

emergencies and improved decision-making. 

Methodology Conduct a needs assessment to identify specific requirements and 

challenges. Design the system architecture and components. Develop and test the 

system. Conduct pilot testing and evaluation. Implement the system on a full scale. 

Expected Outcomes Improved safety and well-being of sewage workers. Enhanced 

real-time monitoring and communication capabilities. Increased efficiency and 

productivity. Reduced costs associated with accidents and injuries. Improved safety and 

well-being of sewage workers. Enhanced operational efficiency and productivity. 

Reduced costs associated with accidents and injuries. Improved decision-making and 

response to emergencies. 

1.1 OBJECTIVE OF THE PROJECT 

Primary Objectives Improve Safety: Enhance the safety and well-being of sewage 

workers by providing real-time monitoring of their vital signs, location, and 

environmental conditions. Enable Real-time Communication: Establish a two-way 

communication system that enables real-time voice and data communication between 

workers and the control center. Enhance Operational Efficiency: Optimize work 

processes and reduce response times to emergencies by providing real-time monitoring 

and communication capabilities. Secondary Objectives Reduce Accidents and Injuries: 

Minimize the number of accidents and injuries by providing early warnings and alerts 

to workers and the control center. Improve Decision-Making: Provide data-driven 

insights to inform decision-making and improve overall operational efficiency. Reduce 
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Costs: Minimize costs associated with accidents, injuries, and equipment damage by 

providing real-time monitoring and communication capabilities. 

1.2 ORGANIZATION OF THE PROJECT 

1. Project Manager: Oversees the entire project, ensuring timely completion, 

budget management, and stakeholder satisfaction. 

2. Technical Lead: Responsible for the technical aspects of the project, including 

system design, development, and testing. 

3.  Safety Expert: Provides expertise on safety protocols, regulations, and best 

practices for sewage workers. 

4. Stakeholder Engagement Team: Responsible for communicating with 

stakeholders, including sewage workers, management, and regulatory bodies. 

5. Hardware Development Team: Designs and develops the wearable devices, 

environmental sensors, and communication infrastructure. 

6. Software Development Team: Develops the software applications for data 

collection, analysis, and visualization. 

7. Testing and Quality Assurance Team: Conducts thorough testing and quality 

assurance of the system. 

8. Deployment and Maintenance Team: Deploys the system and provides 

ongoing maintenance and support. 

9. Requirements Gathering: Identify project requirements, stakeholder needs, 

and technical specifications. 

10.  System Design: Design the system architecture, hardware, and software 

components. 

11. Development: Develop the hardware and software components. 

12. Testing and Quality Assurance: Conduct thorough testing and quality 

assurance 

13. Deployment: Deploy the system. 

14. Maintenance and Support: Provide ongoing maintenance and support. 
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CHAPTER 2 

LITERATURE SURVEY 

2.1 EXISTING SYSTEM 

The sewage maintenance support is important to keep the society neat, clean safe and 

healthy. If the waste upkeep is may quite good at environment and also the human being 

it causes the form a dangerous gas in the water. The wireless sensor networks are mainly 

used to identify the environment changes and stored information in the database. T. 

Machappa, M. Sasikala, and M. V. N. Ambika Prasad exhibited a framework that 

electrical obstruction Weinan Deng and Huaxing Zhang, the building of highways in 

China has led to an increasingly serious problem leaving more and more coal under 

highways. Having as much as possible the unexploited coal and maintaining highway 

safety at the same time becomes a problem that must be addressed as a matter of 

urgency. 

The paper addressed the characteristics of road deformations caused by 

underground mining, suggesting the rules to be followed while mining under highway 

protective coal pillar. Methods for the security mining of protective coal pillar under 

highway were put forward in the study on the basis of improving and integrating the 

existing methods for mining protective coal pillar. 

The importance of the Coal Mine Production Safety Supervision and the specific issues 

that might occur under the concept of safety supervision function is proposed to create 

the Coal Mine Safety Production Supervision Program. The results, show that the 

addition of independent third parties to the coal mine production process 

implementation services in compliance with applicable guidelines, laws, rules and 

regulations and technical standards and the conduct of coal mining companies to 

establish an effective restriction framework can compensate for the government's 

macroscopic control and its own limitations. 

The establishment of the system to provide a reliable guarantee for coal mine safety 

production. Yiqing Zhao, Yaodong Zhou, Cuiping Li and Zhiguo Cao, In the supply 

chain management (SCM) of coal companies, the volatility of the occurrence of raw 

coal and coal quality and the various limitations on mine production capacity are the 

major factors that need to be taken into account. This paper combines a supply chain 

model for coal mine planning with a linear programming model for production 
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scheduling to allow coal companies respond quickly to changes in customer demand 

and boost supply chain and logistics management level. 

The aim of production management and scheduling optimization model is to 

optimize sales volume with customer demand constraints, lead time, resource 

constraints and supply chain inventory. To illustrate the model application and its ability 

to reduce planning and scheduling time and respond to uncertainty, an example of an 

open pit coal mine is used. Liu Xianglan, Big data has infiltrated various industries and 

their functions, has become important development factors in Research Article Volume 

9 Issue No.10 IJESC, October 2019 23932 http://ijesc.org/ the global economy. Big data 

processing is the cornerstone of the big data development process. Big data technology 

should concentrate on processing, analyzing, combining and visualizing unstructured 

data and semi-structured data. Big data will no longer be the core of traditional 

structured data. 

Based on the theory of the life cycle, new digital technologies such as 

collection, processing, storage, organization and copyright protection, clusters of highly 

competitive retrieval and flexible scheduling, smart digital display, coal mine industry 

information data can be collected and incorporated, centralized management, 

coordinated retrieval, and joint information resource exhibition Lab VIEW 

programming environment is developed to connect large area. The leakage level of a 

gas concentration. 

2.2 PROPOSED SYSTEMS 

Hardware Components 

 

1. Wearable Devices: Design and develop wearable devices (e.g., smart vests, 

wristbands) with sensors to monitor workers' vital signs (e.g., heart rate, blood 

oxygen level). 

2. Environmental Sensors: Install environmental sensors (e.g., gas detectors, 

temperature sensors) in the sewage system to monitor environmental conditions. 

3. Communication Infrastructure: Establish a reliable communication 

infrastructure (e.g., Wi-Fi, cellular networks) to enable real-time 

communication between workers and the control center. 

http://ijesc.org/
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Software Components 

1. Data Collection and Analysis: Develop software to collect and analyze data 

from wearable devices and environmental sensors. 

2. Real-time Monitoring: Design a real-time monitoring system to display worker 

vital signs and environmental conditions. 

3. Alert and Alarm System: Develop an alert and alarm system to notify workers 

and the control center of potential hazards. 

4. Two-Way Communication: Implement a two-way communication system to 

enable real-time voice and data communication between workers and the control 

center. 

System Implementation 

1. Needs Assessment: Conduct a needs assessment to identify specific 

requirements and challenges. 

2. System Design: Design the system architecture and components. 

3. Prototype Development: Develop a prototype of the system. 

4. Testing and Evaluation: Conduct thorough testing and evaluation of the system. 

5. Deployment: Deploy the system in the sewage workplace. 

 

Evaluation Metrics 

1. Safety Incident Reduction: Measure the reduction in safety incidents and 

accidents. 

2. Worker Satisfaction: Evaluate worker satisfaction with the system. 

3. Response Time: Measure the response time to emergencies and potential 

hazards. 

4. System Reliability: Evaluate the reliability and uptime of the system. 

 

Advantages 

 

1. Improved Safety: Enhances the safety and well-being of sewage workers by 

providing real-time monitoring of their vital signs and environmental conditions. 

2. Real-time Communication: Enables real-time voice and data communication 

between workers and the control center, facilitating prompt response to 

emergencies. 
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3. Increased Efficiency: Optimizes work processes and reduces response times to 

emergencies, leading to increased productivity and efficiency. 

4. Cost Savings: Reduces costs associated with accidents, injuries, and equipment 

damage. 

5. Enhanced Decision-Making: Provides data-driven insights to inform decision- 

making and improve overall operational efficiency. 

Limitations 

1. Technical Issues: Technical problems, such as connectivity issues or sensor 

malfunctions, may affect the system's reliability. 

2. Cost: Implementing and maintaining the system may require significant 

investment. 

3. User Acceptance: Workers may resist adopting new technology, requiring 

training and support. 

4. Data Security: Ensuring the security and confidentiality of worker data and 

system communications is crucial. 

5. Scalability: The system may require modifications to accommodate changing 

workforce sizes or new technologies. 

Features 

1. Real-time Monitoring: Continuous monitoring of workers' vital signs and 

environmental conditions. 

2. Two-Way Communication: Real-time voice and data communication between 

workers and the control center. 

3. Alert and Alarm System: Automated alerts and alarms for potential hazards and 

emergencies. 

4. Location Tracking: GPS tracking of workers' locations within the sewage 

system. 

5. Data Analytics: Advanced data analytics to identify trends, patterns, and 

potential hazards. 
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CHAPTER 3 

HARDWARE IMPLEMENTATION 

Gas sensors are electronic devices that detect and identify different types of gasses. 

They are commonly used to detect toxic or explosive gasses and measure gas 

concentration. The tin oxide layer acts as a reacting component. When tin dioxide 

(semiconductor particles) is heated in air at high temperature, oxygen is adsorbed on 

the surface. In clean air, donor electrons in tin dioxide are attracted toward oxygen 

which is adsorbed on the surface of the sensing material. This prevents electric current 

flow. In the presence of reducing gases, the surface density of adsorbed oxygen 

decreases as it reacts with the reducing gases. Electrons are then released into the tin 

dioxide, allowing current to flow freely through the sensor. 

3.1 AIR QUALITY SENSOR & GAS SENSOR 

The MQ-135 Gas sensors are used in air quality control equipments and are suitable for 

detecting or measuring of NH3, NOx, Alcohol, Benzene, Smoke, CO2.The MQ-135 

sensor module comes with a Digital Pin which makes this sensor to operate even 

without a microcontroller and that comes in handy when you are only trying to detect 

one particular gas. If you need to measure the gases in PPM the analog pin need to be 

used. The analog pin is TTL driven and works on 5V and so can be used with most 

common microcontroller 

 

 
Fig 3.1: Gas Sensor 

 

3.2 TEMPERATURE SENSOR 

LM35 is a precession Integrated circuit Temperature sensor, whose output voltage 

varies, based on the temperature around it. It is a small and cheap IC which can be used 

to measure temperature anywhere between -55°C to 150°C. It can easily be interfaced 

with any Microcontroller that has ADC function or any development platform like 
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Arduino.It has an output voltage that is proportional to the Celsius temperature.The 

scale factor is 0.1V/oC. The sensor has a sensitivity of 10mV /oC. 

 

 
Fig 3.2: Temperature Sensor 

 

3.3 HEART BEAT SENSOR 

Heart Beat Sensor is designed to give digital output of heat beat when a finger is placed 

on it. When the heart beat detector is working, the beat LED flashes in unison with each 

heart beat. This digital output can be connected to microcontroller directly to measure 

the Beats Per Minute (BPM) rate. The heartbeat sensor is based on the principle of 

photoplethysmography. It measures the change in volume of blood through any organ 

of the body which causes a change in the light intensity through that organ. 

 

 
Fig 3.3: Heart Beat Sensor 
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3.4 ARDUINO UNO 

Arduino board is being used used here. It also reffered as brain which means act as a 

main part in the project. It is connected with GSM which sends message to the user. 

Also an application ‗Ubidots‘ being implied here which used as conversion. Wifi 

modules and LCD display is being connected. Arduino Uno is a MC board based on 8- 

bit ATmega328P MC. Along with ATmega328P, it consists other components such as 

crystal oscillator, serial communication, voltage regulator, etc. to support the MC. 

Arduino Uno has 14 digital input/output pins (out of which 6 can be used as PWM 

outputs), 6 analog input pins, a USB connection, A Power barrel jack, an ICSP header 

and a reset button. 

 

Fig 3.4: Arduino UNO 

 

3.5 ARDUINO MEGA 

The MEGA 2560 is designed for more complex projects. With 54 digital I/O pins ( of 

which 15 can be used as PWM outputs), 16 analog inputs, 4 UART, a 16 MHz crystal 

oscillator,a 16 MHz crystal oscillator, a USB connection, a 

 

Fig 3.5: Arduino Mega 
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power jack, an ICSP header and a reset button.The ATmega1280 has 128 KB of flash 

memory for storing code (of which 4 KB is used for the bootloader), 8 KB of SRAM 

and 4 KB of EEPROM. 

3.6 IOT MODULE 

The ESP8266 is the name of a micro controller designed by Espressif Systems. The 

ESP8266 itself is a self-contained Wi-Fi networking solution offering as a bridge from 

existing micro controller to Wi-Fi.Core processor ESP8266 in smaller sizes of the 

module encapsulates Tensilica L106 integrates industry-leading ultra-low power 32-bit 

MCU micro, with the 16-bit short mode, Clock speed support 80 MHz, 160 MHz, 

supports the RTOS, integrated Wi-Fi MAC/BB/RF/PA/LNA, on-board antenna. The 

module supports standard IEEE802.11 b/g/n agreement, complete TCP/IP protocol 

stack. Users can use the add modules to an existing device networking, or building a 

separate network controller. ESP8266 is high integration wireless SOCs, dthe entire 

solution, including front-end module, is designed to occupy minimal PCB area. 

 

Fig 3.6: ESP8266- IOT Module 

 

3.7 GSM MODULE 

A GSM module or a GPRS module is a chip or circuit that will be used to establish 

communication between a mobile device or a computing machine and a GSM or GPRS 

system. GSM/GPRS Modem-RS232 is built with Dual Band GSM/GPRS engine- 

SIM900, works on frequencies 900/ 1800 MHz. The Modem is coming with RS232 

interface, which allows you connect PC as well as MC with RS232 Chip(MAX232). 

The baud rate is configurable from 9600-115200. The GSM/GPRS Modem is having 

internal TCP/IP stack to enable you to connect with internet via GPRS. It is suitable for 

SMS, Voice as well as Data transfer application in M2M interface. The onboard 

Regulated Power supply allows you to connect wide range unregulated power supply . 
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Using this modem, you can make audio calls, SMS, Read SMS, attend the incoming 

calls and internet through simple AT commands. 
 

Fig 3.7: GSM Module 

 

3.8 ZIGBEE MODULE 

Zigbee is a wireless communication module which use IEEE 802.15.4 standard. 

802.15.4 is a IEEE standard for low power applications of radio frequency. It used serial 

communication to send and receive data.The nRF24L01+ is a single chip 2.4GHz 

transceiver with an embedded baseband protocol engine, suitable for ultra - low power 

wireless applications. The nRF24L01+ is designed for operation in the world wide ISM 

frequency band at 2.4 - 2.4835GHz. The nRF24L01+ is configured in Serial Peripheral 

Interface (SPI). The register map, which is accessible through the SPI, contains all 

configuration registers in then RF24L01+ and is accessible in all operation modes of 

the chip. The radio front end uses GFSK modulation. Baud Rate: 250 kbps to 2 Mbps 

 

Fig 3.8: nRF24L01+ - Zigbee Module 

 

3.9 BUZZER 

Buzzer operates based on piezoelectric effect. Piezoelectric Effect is the ability of 

certain materials to generate an electr ic charge in response to applied mechanical stress. 

Piezoelectric buzzer is mainly composed of multi-resonator, piezoelectric plate, 

impedance match, resonance box, housing, etc. Some of the piezoelectric buzzers are 

also equipped with light-emitting diodes. The multi-resonator consists of transistors or 
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integrated circuits. When the power supply is switched on (1.5~15V DC operating 

voltage), the multi-resonator oscillates and outputs 1.5~2.5kHz audio signal. 

 

 
Fig 3.9: Buzzer 
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BLOCK DIAGRAM 

3.2.1 BLOCK DIAGRAM 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig 3.2.1: Block Diagram 

 

POWER SUPPLY 
 

Fig 3.2.2 Power Supply 
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CHAPTER 4 

SOFTWARE IMPLEMENTATION 

4.1 ARDUINO IDE 

Arduino IDE stands for Integrated Development Environment‖:it is an official software 

introduced by Arduino.cc, that is mainly used for editing, compiling and uploading the 

code in the Arduino Device. It is a cross-platform application (for Windows, macOS, 

Linux) that is written in functions from C and C++.Arduino IDE is an open source 

software that is mainly used for writing and compiling the code into the Arduino 

Module. I serial monitor mainly for interacting with the Arduino board using the 

computer, and is a great tool for real-time monitoring and debugging. 

The Arduino IDE is a comprehensive software platform for writing, compiling, and 

uploading code to Arduino boards. It provides an intuitive interface for programming 

and debugging, making it an ideal choice for beginners and experienced developers 

alike. To program a 16x2 LCD display using the Arduino IDE, users must first install 

the Liquid Crystal library. This library provides a set of functions for controlling the 

LCD display, including initializing the display, setting the cursor position, and printing 

text. Once the library is installed, users can create a new sketch in the Arduino IDE and 

import the Liquid Crystal library. 
 

Fig 4.1: Arduino IDE 

 

They can then define the LCD pins and initialize the display in the setup () function. In 

the loop () function, users can use the Liquid Crystal functions to print text to the LCD 

display. For example, they can use the print () function to print a message to the display, 

or the set Cursor () function to set the cursor position. The Arduino IDE also provides 

a range of debugging tools, including a serial monitor and a debugger. These tools allow 

users to monitor the output of their code and identify any errors that may 
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occur.Overall, the Arduino IDE provides a powerful and intuitive platform for 

programming a 16x2 LCD display. Its comprehensive library and debugging tools make 

it an ideal choice for developers of all levels. Arduino IDE stands for Integrated 

Development Environment‖:it is an official software introduced by Arduino.cc, that is 

mainly used for editing, compiling and uploading the code in the Arduino Device. It is 

a cross-platform application (for Windows, macOS, Linux) that is written in functions 

from C and C++.Arduino IDE is an open source software that is mainly used for writing 

and compiling the code into the Arduino Module. I serial monitor mainly for interacting 

with the Arduino board using the computer, and is a great tool for real-time monitoring 

and debugging. 

The Arduino IDE is a comprehensive software platform for writing, compiling, and 

uploading code to Arduino boards. It provides an intuitive interface for programming 

and debugging, making it an ideal choice for beginners and experienced developers 

alike. To program a 16x2 LCD display using the Arduino IDE, users must first install 

the Liquid Crystal library. This library provides a set of functions for controlling the 

LCD display, including initializing the display, setting the cursor position, and printing 

text. Once the library is installed, users can create a new sketch in the Arduino IDE and 

import the Liquid Crystal library. 

4.2 IOT CLOUD STORAGE WEBPAGE 

IOT describes the network of physical object things that are embedded with sensors, 

software, and other technologies for the purpose of connecting and exchanging data 

with other devices and systems over the internet with unique identifiers (UIDs). A host 

of network protocols for the internet has made it easy to connect sensors to the cloud 

and to other things for efficient data transfer. The data‘s get stored in the cloud. 

 

 
Fig 4.2: IOT 
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The IOT concept was coined by a member of the Radio Frequency Identification 

(RFID) development community in 1999, and it has recently become more relevant to 

the practical world largely because of the growth of mobile devices, embedded and 

ubiquitous communication, cloud computing and data analytics. Imagine a world where 

billions of objects can sense, communicate and share information, all interconnected 

over public or private Internet Protocol (IP) networks. These interconnected objects 

have data regularly collected, analysed and used to initiate action, providing a wealth 

of intelligence for planning, management and decision making. 

This is the world of the Internet of Things (IOT). Internet of things common 

definition is defining as: Internet of things (IOT) is a network of physical objects. The 

internet is not only a network of computers, but it has evolved into a network of device 

of all type and sizes , vehicles, smart phones, home appliances, toys, cameras, medical 

instruments and industrial systems, animals, people, buildings, all connected ,all 

communicating & sharing information based on stipulated protocols in order to achieve 

smart reorganizations, positioning, tracing, safe & control & even personal real time 

online monitoring , online upgrade, process control & administration We define IOT 

into three categories as below. IOT describes the network of physical object things that 

are embedded with sensors, software, and other technologies for the purpose of 

connecting and exchanging data with other devices and systems over the internet with 

unique identifiers (UIDs). A host of network protocols for the internet has made it easy 

to connect sensors to the cloud and to other things for efficient data transfer. The data‘s 

get stored in the cloud. 
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5.1 Arduino 

CHAPTER 5 

COMPONENTS DISCRIPTION 

Overview The Arduino Uno is a microcontroller board based on the ATmega328 

(datasheet). It has 14 digital input/output pins (of which 6 can be used as PWM outputs), 

6 analog inputs, a 16 MHz ceramic resonator, a USB connection, a power jack, an ICSP 

header, and a reset button. It contains everything needed to support the microcontroller; 

simply connect it to a computer with a USB cable or power it with a AC-to-DC adapter 

or battery to get started. The Uno differs from all preceding boards in that it does not 

use the FTDI USB-to-serial driver chip. Instead, it features the Atmega16U2 

(Atmega8U2 up to version R2) programmed as a USB-to-serial converter. Revision 2 

of the Uno board has a resistor pulling the 8U2 HWB line to ground, making it easier 

to put into DFU mode. Revision 3 of the board has the following new features. 

pinout: added SDA and SCL pins that are near to the AREF pin and two other new 

pins placed near to the RESET pin, the IOREF that allow the shields to adapt to the 

voltage provided from the board. In future, shields will be compatible both with the 

board that use the AVR, which operate with 5V and with the Arduino Due that operate 

with 3.3V. The second one is a not connected pin, that is reserved for future purposes. 

Stronger RESET circuit. 

At mega 16U2 replace the 8U2. "Uno" means one in Italian and is named to mark 

the upcoming release of Arduino 1.0. The Uno and version 1.0 will be the reference 

versions of Arduino, moving forward. The Uno is the latest in a series of USB Arduino 

boards, and the reference model for the Arduino platform; for a comparison with 

previous versions, see the index of Arduino boards. It contains everything needed to 

support the microcontroller; simply connect it to a computer with a USB cable or power 

it with a AC-to-DC adapter or battery to get started. The Uno differs from all preceding 

boards in that it does not use the FTDI USB-to-serial driver chip. Instead, it features the 

Atmega16U2 (Atmega8U2 up to version R2) programmed as a USB-to-serial converter. 
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Summary: 

 

Microcontroller ATmega328 

Operating Voltage 5V 

Input Voltage (recommended) 7-12V 

Input Voltage (limits) 6-20V 

Digital I/O Pins 14 (of which 6 provide PWM output) 

Analog Input Pins 6 

DC Current per I/O Pin 40 mA 

DC Current for 3.3V Pin 50 mA 

Flash Memory 32 KB (ATmega328) of which 0.5 KB used by bootloader 

SRAM 2 KB (ATmega328) 

EEPROM 1 KB (ATmega328) 

 

Clock Speed 16 MHz 

Clock Speed 16 MHz 

 

 
Fig 5.1: Arduino 
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Schematic & Reference Design 

EAGLE files: arduino-uno-Rev3-reference-design.zip (NOTE: works with Eagle 6.0 

and newer) Schematic: arduino-uno-Rev3-schematic.pdf Note: The Arduino reference 

design can use an Atmega8, 168, or 328, Current models use an ATmega328, but an 

Atmega8 is shown in the schematic for reference. The pin configuration is identical on 

all three processors 

Power 

The Arduino Uno can be powered via the USB connection or with an external power 

supply. The power source is selected automatically. 

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or 

battery. 

The adapter can be connected by plugging a 2.1mm center-positive plug into the board's 

power jack. 

Leads from a battery can be inserted in the Gnd and Vin pin headers of the POWER 

connector. 

The board can operate on an external supply of 6 to 20 volts. 

If supplied with less than 7V, however, the 5V pin may supply less than five volts and 

the board may be unstable. 

If using more than 12V, the voltage regulator may overheat and damage the board. The 

recommended range is 7 to 12 volts. 

The power pins are as follows: 

VIN. The input voltage to the Arduino board when it's using an external power source 

(as opposed to 5 volts from the USB connection or other regulated power source). You 

can supply voltage through this pin, or, if supplying voltage via the power jack, access 

it through this pin. 

5V. This pin outputs a regulated 5V from the regulator on the board. The board can be 

supplied with power either from the DC power jack (7 - 12V), the USB connector (5V), 

or the VIN pin of the board (7-12V). Supplying voltage via the 5V or 3.3V pins bypasses 

the regulator, and can damage your board. We don't advise it. 3V3. A 3.3volt supply 

generated by the on-board regulator. Maximum current draw is 50 mA. 

GND. Ground pins. 
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Memory: The ATmega328 has 32 KB (with 0.5 KB used for the bootloader). It also 

has 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the 

EEPROM library). 

Input and Output: Each of the 14 digital pins on the Uno can be used as an input or 

output, using pin Mode(), digital Write(), and digital Read() functions. They operate at 

5 volts. Each pin can provide or receive a maximum of 40 mA and has an internal pull- 

up resistor (disconnected by default) of 20-50k Ohms. In addition, some pins have 

specialized functions. 

 Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. 

These pins are connected to the corresponding pins of the ATmega8U2 USB-to-TTL 

Serial chip. 

 External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on 

a low value, a rising or falling edge, or a change in value. See the attachInterrupt() 

function for details. 

 PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() 

function. 

 SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI 

communication using the SPI library. 

 LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH 

value, the LED is on, when the pin is LOW, it's off. The Uno has 6analog inputs, labelled 

A0 through A5, each of which provide 10 bits of resolution (i.e. 1024 different values). 

By default they measure from ground to 5 volts, though is it possible to change the 

upper end of their range using the AREF pin and the analog Reference () function. 

Additionally, some pins have specialized functionality: 

 TWI: A4 or SDA pin and A5 or SCL pin. Support TWI communication using the Wire 

library. There are a couple of other pins on the board: 

 AREF. Reference voltage for the analog inputs. Used with analog Reference . 

 Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset 

button to shields which block the one on the board. See also the mapping between 

Arduino pins and ATmega328 ports. The mapping for the Atmega8, 168, and 328 is 

identical. 



21  

Communication: 

The Arduino Uno has a number of facilities for communicating with a computer, 

another Arduino, or other microcontrollers. The ATmega328 provides UART TTL (5V) 

serial communication, which is available on digital pins 0 (RX) and 1 (TX). An 

ATmega16U2 on the board channels this serial communication over USB and appears 

as a virtual com port to software on the computer. The '16U2 firmware uses the standard 

USB COM drivers, and no external driver is needed. However, on Windows, a .inf file 

is required. 

The Arduino software includes a serial monitor which allows simple textual data 

to be sent to and from the Arduino board. The RX and TX LEDs on the board will flash 

when data is being transmitted via the USB-to-serial chip and USB connection to the 

computer (but not for serial communication on pins 0 and 1). A Software Serial library 

allows for serial communication on any of the Uno's digital pins. The ATmega328 also 

supports I2C (TWI) and SPI communication. The Arduino software includes a Wire 

library to simplify use of the I2C bus; see the documentation for details. For SPI 

communication, use the SPI library. 

5.2 POWER SUPPLY: 

The input to the circuit is applied from the regulated power supply. The a.c. input i.e., 

230V from the mains supply is step down by the transformer to 12V and is fed to a 

rectifier. The output obtained from the rectifier is a pulsating d.c voltage. So, in order 

to get a pure d.c voltage, the output voltage from the rectifier is fed to a filter to remove 

any a.c components present even after rectification. Now, this voltage is given to a 

voltage regulator to obtain a pure constant dc voltage. A power supply is a crucial device 

that provides power to a device or system, converting input power from the grid or a 

battery to the required output voltage. It's essential to choose a power supply that 

matches the device's or system's voltage and current requirements. Different types of 

power supplies are available, including wall adapters. 
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ATX power supplies for desktop computers, and switching power supplies. When using 

a power supply, safety precautions should be taken, such as using the correct voltage, 

avoiding overheating, and handling the device with care. 

 

Fig 5.2: Block Diagram Of Power Supply 
 

 

 

 

 

 

Fig 5.3: Circuit Diagram of Power supply 

 

5.3 STEP DOWN TRANSFORMER: 

A Stepdown Transformer is the one which reduces the output voltage that means it 

functions for converting high voltage with low current into a low voltage with high 

current. Usually, DC voltages are required to operate various electronic equipment and 

these voltages are 5V, 9V or 12V. But these voltages cannot be obtained directly. Thus, 

the a.c input available at the mains supply i.e., 230V is to be brought down to the 

required voltage level. This is done by a transformer. Thus, a stepdown transformer is 

employed to decrease the voltage to a required level. Depending on the different areas 

sometimes, voltages are stepped down to 230v or 440v for the safety reasons. 
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But to make this reduction in voltages a reality, the number of turns on secondary 

winding or coils is kept less than the primary winding or coils that ultimately result in 

less voltage being induced at the secondary output of the transformer. 

5.4 RECTIFIER: 

The output from the transformer is fed to the rectifier. It converts A.C. into pulsating 

D.C. The rectifier may be a half wave or a full wave rectifier. In this project, a bridge 

rectifier is used because of its merits like good stability and full wave rectification. 

The process is known as , since it "straightens" the direction of current. Rectifiers have 

many uses, but are often found serving as components of DC power supplies and high 

voltage direct current power transmission systems. Depending on the type of alternating 

current supply and the arrangement of the rectifier circuit, the output voltage may 

require additional smoothing to produce a uniform steady voltage. 

5.5 FILTER: 

Capacitive filter is used in this project.In power supplies, capacitors are used to smooth 

(filter) the pulsating DC output after rectification so that a nearly constant DC voltage 

is supplied to the load. The pulsating output of the rectifiers has an average DC value 

and an AC portion that is called ripple voltage. Filter capacitors reduce the amount of 

ripple voltage to a level that is acceptable.In a filter circuit the capacitor is charged to 

the peak of the rectified input voltage during the positive portion of the input. When the 

input goes negative, the capacitor begins to discharge into the load. It removes the 

ripples from the output of rectifier and smoothens the D.C. Output received from this 

filter is constant until the mains voltage and load is maintained constant. However, if 

either of the two is varied, D.C. voltage received at this point changes. Therefore, a 

regulator is applied at the output stage. 

5.6 VOLTAGE REGULATOR: 

As the name itself implies, it regulates the input applied to it. A voltage regulator is an 

electrical regulator designed to automatically maintain a constant voltage level.The 

voltage regulator monitors the current drawn by the load and increases or decreases the 

voltage accordingly to keep the voltage level constant. A voltage regulator may use a 

simple feed-forward design or may include negative feedback. It may use an 

electromechanical mechanism, or electronic components. Depending on the design, it 

may be used to regulate one or more AC or DC voltages. In this project, power supply 
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of 5V and 12V are required. In order to obtain these voltage levels, 7805 and 7812 

voltage regulators are to be used. The first number 78 represents positive supply and 

the numbers 05, 12 represent the required output voltage levels. The most popular type 

of voltage regulator IC is the 78XX series, sometimes called the LM78XX series. 

Features: 

• Output Current up to 1A. 

• Output Voltages of 5, 6, 8, 9, 10, 12, 15, 18, 24V. 

• Thermal Overload Protection. 

• Short Circuit Protection. 

• Output Transistor Safe Operating Area Protection. 

5.7 DHT SENSOR: 

Humidity is the measure of water vapour present in the air. The level of humidity in air 

affects various physical, chemical and biological processes. In industrial applications, 

humidity can affect the business cost of the products, health and safety of the 

employees. So, in semi conductors industries and control system industries 

measurement of humidity is very important. Humidity measurement determines the 

amount of moisture present in the gas that can be a mixture of water vapour, nitrogen, 

argon or pure gas etc… Humidity sensors are of two types based on their measurement 

units. They are a relative humidity sensor and Absolute humidity sensor. DHT11 is a 

digital temperature and humidity sensor. 

HT11 is a low-cost digital sensor for sensing temperature and humidity. This 

sensor can be easily interfaced with any micro-controller such as Arduino, Raspberry 

Pi etc… to measure humidity and temperature instantaneously. 

5.8 WORKING: 

DHT11 sensor consists of a capacitive humidity sensing element and a thermistor for 

sensing temperature. The humidity sensing capacitor has two electrodes with a moisture 

holding substrate as a dielectric between them. Change in the capacitance value occurs 

with the change in humidity levels. The IC measure, process this changed resistance 

values and change them into digital form. For measuring temperature this sensor uses a 

Negative Temperature coefficient thermistor, which causes a decrease in its resistance 

value with increase in temperature. To get larger resistance value even for the smallest 

change in temperature, this sensor is usually made up of semiconductor 
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ceramics or polymers. The temperature range of DHT11 is from 0 to 50 degree Celsius 

with a 2-degree accuracy. Humidity range of this sensor is from 20 to 80% with 5% 

accuracy. The sampling rate of this sensor is 1Hz.i.e. it gives one reading for every 

second. DHT11 is small in size with operating voltage from 3 to 5 volts. The maximum 

current used while measuring is 2.5mA. 

The Smart Safety Monitoring System for Sewage Workers is designed to enhance the 

safety of sewage workers by continuously monitoring their health and environmental 

conditions while providing real-time two-way communication with supervisors. The 

system uses IoT sensors, wearable devices, and a central monitoring unit to detect 

hazards and alert both the worker and control room in emergencies. Wearable Safety 

Device for Workers Gas Sensors (H2S, CH4, CO, O2 levels) Detects toxic gases and 

oxygen deficiency. Heart Rate & Body Temperature Sensor Monitors worker’s health 

(fatigue, heat stress). Fall Detection Sensor (Accelerometer/Gyroscope) Alerts if a 

worker collapses. GPS Tracking Provides real-time location. Water proof & 

Shockproof Design Suitable for harsh sewage environments. Two-Way 

Communication Module Bluetooth/Wi-Fi/LoRa/4G Connectivity Ensures 

communication even in underground sewage. Push-to-Talk (PTT) Button Allows 

instant voice communication with the control room. Speaker & Microphone Enables 

clear audio transmission. Central Monitoring System (Control Room) Real-Time 

Dashboard Displays worker vitals, gas levels, and location. Alerts & Notifications 

Sends SMS/app alerts in case of emergencies. Cloud Storage Logs data for analysis and 

compliance. Emergency Protocols Automatic SOS Trigger. If gas levels exceed safety 

limits or a fall is detected. 

Evacuation Alarm Alerts nearby workers in case of danger rescue Coordination. Directs 

rescue teams using GPS data. 

How It Works? 

Step 1: Continuous Monitoring 

- Sensors on the wearable device track gas levels, heart rate, and movement. 

- Data is transmitted to the control room via LoRa/4G for underground areas. 

Step 2: Hazard Detection & Alerts 

If toxic gas (H2S/CH4) is detected, the system triggers: 

Vibration & Audio Alarm on the worker’s device. 

Alert to Control Room with worker’s location. 

if heart rate spikes or a fall is detected, an SOS is sent automatically. 
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Step 3: Two-Way Communication 

- Worker presses PTT button to communicate with supervisors. 

- Control room can broadcast warnings to all workers in the area. 

Step 4: Emergency Response 

- Supervisors dispatch rescue teams using real-time GPS tracking. 

- Historical data helps in post-incident analysis. 

 

DHT11 sensor consists of a capacitive humidity sensing element and a thermistor 

for sensing temperature. The humidity sensing capacitor has two electrodes with a 

moisture holding substrate as a dielectric between them. Change in the capacitance 

value occurs with the change in humidity levels. The IC measure, process this changed 

resistance values and change them into digital form. For measuring temperature this 

sensor uses a Negative Temperature coefficient thermistor, which causes a decrease in 

its resistance value with increase in temperature. To get larger resistance value even for 

the smallest change in temperature, this sensor is usually made up of semiconductor 

ceramics or polymers. The temperature range of DHT11 is from 0 to 50 degree Celsius 

with a 2-degree accuracy. Humidity range of this sensor is from 20 to 80% with 5% 

accuracy. The sampling rate of this sensor is 1Hz.i.e. it gives one reading for every 

second. DHT11 is small in size with operating voltage from 3 to 5 volts. The maximum 

current used while measuring is 2.5mA. 

Power 

The Arduino Uno can be powered via the USB connection or with an external power 

supply. The power source is selected automatically. 

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or 

battery. 

The adapter can be connected by plugging a 2.1mm center-positive plug into the board's 

power jack. 

Leads from a battery can be inserted in the Gnd and Vin pin headers of the POWER 

connector. 

The board can operate on an external supply of 6 to 20 volts. 

If supplied with less than 7V, however, the 5V pin may supply less than five volts and 

the board may be unstable. 

If using more than 12V, the voltage regulator may overheat and damage the board. The 

recommended range is 7 to 12 volts. 
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The power pins are as follows: 

VIN. The input voltage to the Arduino board when it's using an external power source 

(as opposed to 5 volts from the USB connection or other regulated power source). You 

can supply voltage through this pin, or, if supplying voltage via the power jack, access 

it through this pin. 

5V. This pin outputs a regulated 5V from the regulator on the board. The board can be 

supplied with power either from the DC power jack (7 - 12V), the USB connector (5V), 

or the VIN pin of the board (7-12V). Supplying voltage via the 5V or 3.3V pins bypasses 

the regulator, and can damage your board. We don't advise it. 3V3. A 3.3volt supply 

generated by the on-board regulator. Maximum current draw is 50 mA. 

GND. Ground pins. 

 

Memory: The ATmega328 has 32 KB (with 0.5 KB used for the bootloader). It also 

has 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the 

EEPROM library). 

Input and Output: Each of the 14 digital pins on the Uno can be used as an input or 

output, using pin Mode(), digital Write(), and digital Read() functions. They operate at 

5 volts. Each pin can provide or receive a maximum of 40 mA and has an internal pull- 

up resistor (disconnected by default) of 20-50k Ohms. In addition, some pins have 

specialized functions. 

 Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. 

These pins are connected to the corresponding pins of the ATmega8U2 USB-to-TTL 

Serial chip. 

 External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a 

low value, a rising or falling edge, or a change in value. See the attachInterrupt() 

function for details. 

 PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() 

function. 

 SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI 

communication using the SPI library. 

 LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH 

value, the LED is on, when the pin is LOW, it's off. The Uno has 6analog inputs, labelled 

A0 through A5, each of which provide 10 bits of resolution (i.e. 1024 different values). 
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By default they measure from ground to 5 volts, though is it possible to change the 

upper end of their range using the AREF pin and the analog Reference () function. 

Additionally, some pins have specialized functionality: 

 TWI: A4 or SDA pin and A5 or SCL pin. Support TWI communication using the Wire 

library. There are a couple of other pins on the board: 

 AREF. Reference voltage for the analog inputs. Used with analog Reference . 

 Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset 

button to shields which block the one on the board. See also the mapping between 

Arduino pins and ATmega328 ports. The mapping for the Atmega8, 168, and 328 is 

identical. 

Communication: 

The Arduino Uno has a number of facilities for communicating with a computer, 

another Arduino, or other microcontrollers. The ATmega328 provides UART TTL (5V) 

serial communication, which is available on digital pins 0 (RX) and 1 (TX). An 

ATmega16U2 on the board channels this serial communication over USB and appears 

as a virtual com port to software on the computer. The '16U2 firmware uses the standard 

USB COM drivers, and no external driver is needed. However, on Windows, a .inf file 

is required. 

The Arduino software includes a serial monitor which allows simple textual data 

to be sent to and from the Arduino board. The RX and TX LEDs on the board will flash 

when data is being transmitted via the USB-to-serial chip and USB connection to the 

computer (but not for serial communication on pins 0 and 1). A Software Serial library 

allows for serial communication on any of the Uno's digital pins. The ATmega328 also 

supports I2C (TWI) and SPI communication. The Arduino software includes a Wire 

library to simplify use of the I2C bus; see the documentation for details. For SPI 

communication, use the SPI library. The Arduino software includes a serial monitor 

which allows simple textual data to be sent to and from the Arduino board. The RX and 

TX LEDs on the board will flash when data is being transmitted via the USB-to-serial 

chip and USB connection to the computer (but not for serial communication on pins 0 

and 1). A Software Serial library allows for serial communication on any of the Uno's 

digital pins. The ATmega328 also supports I2C (TWI) and SPI communication. The 

Arduino software includes a Wire library to simplify use of the I2C bus; see the 

documentation for details. For SPI communication, use the SPI library. The Arduino 
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software includes a serial monitor which allows simple textual data to be sent to and 

from the Arduino board. The RX and TX LEDs on the board will flash when data is 

being transmitted via the USB-to-serial chip and USB connection to the computer (but 

not for serial communication on pins 0 and 1). A Software Serial library allows for serial 

communication on any of the Uno's digital pins. The ATmega328 also supports I2C 

(TWI) and SPI communication. 

 

 
Fig 5.4: Capacitor 

 

Applications 

This sensor is used in various applications such as measuring humidity and temperature 

values in heating, ventilation and air conditioning systems. Weather stations also use 

these sensors to predict weather conditions. The humidity sensor is used as a preventive 

measure in homes where people are affected by humidity. Offices, cars, museums, 

greenhouses and industries use this sensor for measuring humidity values and as a safety 

measure. 

5.9 GAS SENSOR: 

A gas detector is a device that detects the presence of gases in an area, often as part of 

a safety system. A gas detector can sound an alarm to operators in the area where the 

leak is occurring, giving them the opportunity to leave. This type of device is important 

because there are many gases that can be harmful to organic life, such as humans or 

animals. 

Gas leak detection is the process of identifying potentially hazardous gas by 

sensors. Additionally a visual identification can be done using a thermal camera These 

sensors usually employ an audible alarm to alert people when a dangerous gas has been 

detected. Exposure to toxic gases can also occur in operations such as painting, 

fumigation, fuel filling, construction, excavation of contaminated soils, landfill 

operations, entering confined spaces, etc. Common sensors include combustible gas 

sensors, photoionization detector sensors (MOS sensors). More recently, infrared 
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imaging sensors have come into use. All of these sensors are used for a wide range of 

applications and can be found in industrial plants, refineries, pharmaceutical 

manufacturing, fumigation facilities, paper pulp mills, aircraft and shipbuilding 

facilities, hazmat operations, waste-water treatment facilities, vehicles, indoor air 

quality testing and homes. 

 

 

Fig 5.5: Gas Sensor 

 

5.10 PULSE SENSOR 

Heartbeat. Monitoring body temperature, heart rate and blood pressure are the basic 

things that we do in order to keep us healthy. n order to measure the body temperature, 

we use thermometers and a sphygmomanometer to monitor the Arterial Pressure or 

Blood Pressure. Heart Rate can be monitored in two ways: one way is to manually check 

the pulse either at wrists or neck and the other way is to use a Heartbeat Sensor. In this 

project, we have designed a Heart Rate Monitor System using Arduino and Heartbeat 

Sensor. You can find the Principle of Heartbeat Sensor, working of the Heartbeat Sensor 

and Arduino based Heart Rate Monitoring System using a practical heart beat Sensor. 

5.11 INTRODUCTION TO HEARTBEAT SENSOR 

Monitoring heart rate is very important for athletes, patients as it determines the 

condition of the heart (just heart rate). There are many ways to measure heart rate and 

the most precise one is using an Electro cardiography. But the more easy way to monitor 

the heart rate is to use a Heartbeat Sensor. It comes in different shapes and sizes and 

allows an instant way to measure the heartbeat. 

Heartbeat Sensors are available in Wrist Watches (Smart Watches), Smart Phones, chest 

straps, etc. The heartbeat is measured in beats per minute or bpm, which indicates the 

number of times the heart is contracting or expanding in a minute. Monitoring heart rate 

is very important for athletes, patients as it determines the condition of the heart (just 

heart rate). There are many ways to measure heart rate and the most precise one is using 
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an Electro cardiography. But the more easy way to monitor the heart rate is to use a 

Heartbeat Sensor. It comes in different shapes and sizes and allows an instant way to 

measure the heartbeat. 

 

 
Fig 5.6: Principle of Heartbeat Sensor 

 

The principle behind the working of the Heartbeat Sensor is Photplethysmo graph. 

According to this principle, the changes in the volume of blood in an organ is measured 

by the changes in the intensity of the light passing through that organ. Usually, the 

source of light in a heartbeat sensor would be an IR LED and the detector would be any 

Photo Detector like a Photo Diode, an LDR (Light Dependent Resistor) or a Photo 

Transistor. With these two i.e. a light source and a detector, we can arrange them in two 

ways: A Transmissive Sensor and a Reflective Sensor. In a Transmissive Sensor, the 

light source and the detector are place facing each other and the finger of the person 

must be placed in between the transmitter and receiver. Reflective Sensor, on the other 

hand, has the light source and the detector adjacent to each other and the finger of the 

person must be placed in front of the sensor. Monitoring heart rate is very important for 

athletes, patients as it determines the condition of the heart (just heart rate). There are 

many ways to measure heart rate and the most precise one is using an Electro 

cardiography. But the more easy way to monitor the heart rate is to use a Heartbeat 

Sensor. It comes in different shapes and sizes and allows an instant way to measure the 

heartbeat. 

5.12 Working Of Heartbeat Sensor 

A simple Heartbeat Sensor consists of a sensor and a control circuit. The sensor part of 

the Heartbeat Sensor consists of an IR LED and a Photo Diode placed in a clip. The 

Control Circuit consists of an Op-Amp IC and few other components that help in 
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connecting the signal to a Microcontroller. The working of the Heartbeat Sensor can be 

understood better if we take a look at its circuit diagram. 

 

 
Fig 5.7: Working Of Heat Beat 

 

The above circuit shows the finger type heartbeat sensor, which works by detecting the 

pulses. Every heartbeat will alter the amount of blood in the finger and the light from 

the IR LED passing through the finger and thus detected by the Photo Diode will also 

vary. The output of the photo diode is given to the non inverting input of the first op 

amp through a capacitor, which blocks the DC Components of the signal. The first op 

amp cats as a non -inverting amplifier with an amplification factor of 1001. The output 

of the first op amp is given as one of the inputs to the second op amp, which acts as a 

comparator. The output of the second op amp triggers a transistor, from which, the 

signal is given to a Microcontroller like Arduino. The Op amp used in this circuit is 

LM358. It has two op amps on the same chip. Also, the transistor used is a BC547. An 

LED, which is connected to transistor, will blink when the pulse is detected. 

5.13 WIFI 

A wireless network uses radio waves, just like cell phones, televisions and radios do. In 

fact, communication across a wireless network is a lot like two-way radio 

communication. 

Here's what happens: 

A computer's wireless adapter translates data into a radio signal and transmits it using 

an antenna. A wireless router receives the signal and decodes it. The router sends the 

information to the Internet using a physical, wired Ethernet connection. 
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The process also works in reverse, with the router receiving information from the 

Internet, translating it into a radio signal and sending it to the computer's wireless 

adapter. The radios used for Wi-Fi communication are very similar to the radios used 

for walkie-talkies, cell phones and other devices. They can transmit and receive radio 

waves, and they can convert 1s and 0s into radio waves and convert the radio waves 

back into 1s and 0s. But Wi-Fi radios have a few notable differences from other radios: 

They transmit at frequencies of 2.4 GHz or 5 GHz. This frequency is considerably 

higher than the frequencies used for cell phones, walkie-talkies and televisions. The 

higher frequency allows the signal to carry more data.They use 802.11 networking 

standards 

How does it work? 

A small device known as a wireless transmitter, or hub, is required; this device receives 

information from the internet via your home broadband connection. This transmitter 

(often referred to as a Wireless Access Point, or WAP) then converts this information 

into radio waves and emits it, effectively creating a small, local area around itself, 

within which your devices can receive these radio signals if they are fitted with the 

correct kind of wireless adapter. This area is often termed a Wireless Local Area 

Network, or WLAN for short. The radio signals aren’t very strong, which is why the 

Wi-Fi signal doesn’t travel very far; it will travel far enough to cover throughout the 

average home and to the street directly outside, for example, but not much further. 
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802.11 systems and bands: 

 

There are several different 802.11 variants in use. Different 802.11 variants use different 

bands. A summary of the bands used by the 802.11 systems is given below: 

 

IEEE 802.11 

VARIANT 

FREQUENCY BANDS 

USED 

COMMENTS 

802.11a 5GHz Read more 

about 802.11a 

802.11b 2.4GHz Read more 

about 802.11b 

802.11g 2.4GHz Read more 

about 802.11g 

802.11n 2.4 & 5 GHz Read more 

about 802.11n 

802.11ac Below 6GHz Read more 

about 802.11ac 

802.11ad Up to 60 GHz Read more 

about 802.11ad 

802.11af TV white space (below 1 

GHz) 

Read more 

about 802.11af 

802.11ah 700 MHz, 860MHz, 902 

MHz, etc. ISM bands 

dependent upon country 

and allocations 

Read more 

about 802.11ah 

 

 
Table 1: Frequency Bands 

http://www.radio-electronics.com/info/wireless/wi-fi/ieee-802-11a.php
http://www.radio-electronics.com/info/wireless/wi-fi/ieee-802-11b.php
http://www.radio-electronics.com/info/wireless/wi-fi/ieee-802-11g.php
http://www.radio-electronics.com/info/wireless/wi-fi/ieee-802-11n.php
http://www.radio-electronics.com/info/wireless/wi-fi/ieee-802-11ac-gigabit.php
http://www.radio-electronics.com/info/wireless/wi-fi/ieee-802-11ad-microwave.php
http://www.radio-electronics.com/info/wireless/wi-fi/ieee-802-11af-white-fi-tv-space.php
http://www.radio-electronics.com/info/wireless/wi-fi/ieee-802-11ah-sub-ghz-wifi.php
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How Wi-Fi Networks Works 

Wi-Fi networks have no physical wired connection between sender and receiver by 

using radio frequency (RF) technology -- a frequency within the electromagnetic 

spectrum associated with radio wave propagation. When an RF current is supplied to 

an antenna, an electromagnetic field is created that then is able to propagate through 

space. 

 

 

 

Fig 5.8: wifi 

 

The cornerstone of any wireless network is an access point (AP). The primary job of 

an access point is to broadcast a wireless signal that computers can detect and "tune" 

into. In order to connect to an access point and join a wireless network, computers and 

devices must be equipped with wireless network adapters. 

The Wi-Fi Alliance 

The Wi-Fi Alliance, the organization that owns the Wi-Fi registered trademark term 

specifically defines Wi-Fi as any "wireless local area network (WLAN) products that 

are based on the Institute of Electrical and Electronics Engineers' (IEEE) 802.11 

standards." 

Initially, Wi-Fi was used in place of only the 2.4GHz 802.11b standard; however 

the Wi-Fi Alliance has expanded the generic use of the Wi-Fi term to include any type 

of  network  or wlan product  based  on  any  of  the 802.11  standards, including 

802.11b, 802.11a, dual-band and so on, in an attempt to stop confusion about wireless 

LAN interoperability. 

Wi-Fi Support in Applications and Devices 

Wi-Fi is supported by many applications and devices including video game consoles, 

home networks, PDAs, mobile phones, major operating systems, and other types 

https://www.webopedia.com/TERM/I/IEEE.html
https://www.webopedia.com/TERM/8/802_11.html
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of consumer electronics. Any products that are tested and approved as "Wi-Fi Certified"  

(a  registered  trademark)  by  the Wi-Fi  Alliance are  certified as interoperable 

with each other, even if they are from different manufacturers. For example, a user with 

a Wi-Fi Certified product can use any brand of Acees point with any other brand of 

client hardware that also is also "Wi-Fi Certified". 

5.14 SWITCHES 

A switch is an electrical that can disconnect or connect the conducting path in 

an electrical current, interrupting the electrical or diverting it from one conductor to 

another. The most common type of switch is an electromechanical device consisting of 

one or more sets of movable electrical connected to external circuits. When a pair of 

contacts is touching current can pass between them, while when the contacts are 

separated no current can flow. 

Switches are made in many different configurations; they may have multiple sets 

of contacts controlled by the same knob or actuator, and the contacts may operate 

simultaneously, sequentially, or alternately. A switch may be operated manually, for 

example, a light switching or a keyboard button, or may function as a sensing 

element to sense the position of a machine part, liquid level, pressure, or temperature, 

such as a Many specialized forms exist, such as the switch, and . A common use is 

control of lighting, where multiple switches may be wired into one circuit to allow 

convenient control of light fixtures. Switches in high-powered circuits must have 

special construction to prevent destructive arcing when they are opened. 

The most familiar form of switch is a manually operated electromechanical 

device with one or more sets of which are connected to external circuits. Each set of 

contacts can be in one of two states: either "closed" meaning the contacts are touching 

and electricity can flow between them, or "open", meaning the contacts are separated 

and the switch is nonconducting. The mechanism actuating the transition between these 

two states (open or closed) are usually (there are other types of actions) either an 

"alternate action" (flip the switch for continuous "on" or "off") or "momentary" (push 

for "on" and release for "off") type. 

A switch may be directly manipulated by a human as a control signal to a system, 

such as a computer keyboard button, or to control power flow in a circuit, such as 
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a light. Automatically operated switches can be used to control the motions of machines, 

for example, to indicate that a garage door has reached its full open position or that a 

machine tool is in a position to accept another workpiece. Switches may be operated by 

process variables such as pressure, temperature, flow, current, voltage, and force, acting 

as sensor in a process and used to automatically control a system. For example, a 

thermostat is a temperature-operated switch used to control a heating process. A switch 

that is operated by another electrical circuit is called a relay. Large switches may be 

remotely operated by a motor drive mechanism. Some switches are used to isolate 

electric power from a system, providing a visible point of isolation that can be 

padlocked if necessary to prevent accidental operation of a machine during 

maintenance, or to prevent electric shock. 

Switches are made in many different configurations; they may have multiple sets 

of contacts controlled by the same knob or actuator, and the contacts may operate 

simultaneously, sequentially, or alternately. A switch may be operated manually, for 

example, a light switching or a keyboard button, or may function as a sensing 

element to sense the position of a machine part, liquid level, pressure, or temperature, 

such as a Many specialized forms exist, such as the switch, and . A common use is 

control of lighting, where multiple switches may be wired into one circuit to allow 

convenient control of light fixtures. Switches in high-powered circuits must have 

special construction to prevent destructive arcing when they are opened. 

An ideal switch would have no voltage drop when closed, and would have no 

limits on voltage or current rating. It would have zero rise time and fall time during 

state changes, and would change state without "bouncing" between on and off positions. 

Practical switches fall short of this ideal; as the result of roughness and oxide films, 

they exhibit contact resistance, limits on the current and voltage they can handle, finite 

switching time, etc. The ideal switch is often used in circuit analysis as it greatly 

simplifies the system of equations to be solved, but this can lead to a less accurate 

solution. Theoretical treatment of the effects of non-ideal properties is required in the 

design of large networks of switches, as for example used in telephone exchanges. 
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CHAPTER 6 

IOT 

6.1 INTERNET OF THINGS-IOT: 

The IOT concept was coined by a member of the Radio Frequency Identification 

(RFID) development community in 1999, and it has recently become more relevant to 

the practical world largely because of the growth of mobile devices, embedded and 

ubiquitous communication, cloud computing and data analytics. Imagine a world where 

billions of objects can sense, communicate and share information, all interconnected 

over public or private Internet Protocol (IP) networks. These interconnected objects 

have data regularly collected, analysed and used to initiate action, providing a wealth 

of intelligence for planning, management and decision making. 

This is the world of the Internet of Things (IOT). Internet of things common 

definition is defining as: Internet of things (IOT) is a network of physical objects. The 

internet is not only a network of computers, but it has evolved into a network of device 

of all type and sizes , vehicles, smart phones, home appliances, toys, cameras, medical 

instruments and industrial systems, animals, people, buildings, all connected ,all 

communicating & sharing information based on stipulated protocols in order to achieve 

smart reorganizations, positioning, tracing, safe & control & even personal real time 

online monitoring , online upgrade, process control & administration We define IOT 

into three categories as below. 

 

 
Fig 6.1: IOT 

 

Internet of things is an internet of three things People to people, People to machine 

things, machine to things machine, Interacting through internet. Internet of Things 

Vision: Internet of Things (IoT) is a concept and a paradigm that considers pervasive 
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presence in the environment of a variety of things/objects that through wireless and 

wired connections and unique addressing schemes are able to interact with each other 

and cooperate with other things/objects to create new applications/services and reach 

common goals. In this context the research and development challenges to create a 

smart world are enormous. A world where the real, digital and the virtual are converging 

to create smart environments that make energy, transport, cities and many other areas 

more intelligent. 

Internet of Things is refer to the general idea of things, especially everyday 

objects, that are readable, recognisable, locatable, addressable through information 

sensing device and/or controllable via the Internet, irrespective of the communication 

means (whether via RFID, wireless LAN, wide area networks, or other means). 

Everyday objects include not only the electronic devices we encounter or the products 

of higher technological development such as vehicles and equipment but things that we 

do not ordinarily think of as electronic at all - such as food , clothing ,chair, animal, 

tree, water etc. 

Internet of Things is a new revolution of the Internet. Objects make themselves 

recognizable and they obtain intelligence by making or enabling context related 

decisions thanks to the fact that they can communicate information about themselves. 

They can access information that has been aggregated by other things, or they can be 

components of complex services. This transformation is concomitant with the 

emergence of cloud computing capabilities and the transition of the Internet towards 

IPv6 with an almost unlimited addressing capacity. The goal of the Internet of Things 

is to enable things to be connected anytime, anyplace, with anything and anyone ideally 

using any path/network and any service. 

Many technological advancements have accelerated IoT. A few key 

advancements include the following: Sensors and actuators. Environmental changes 

such as temperature, humidity, light, motion or pressure is detected by sensors, while 

actuators cause physical changes such as opening a valve or turning on a motor. 

Connectivity and network protocols. The availability of a host of network protocols for 

the internet has made it easy to connect sensors to the cloud and to other devices, 

facilitating efficient data transfer. IoT employs a range of connectivity technologies, 

including WiFi, Bluetooth, cellular, Zigbee and LoRa WAN. Low cost and low power 
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sensor technology. More manufacturers now have access to IoT technology due to the 

availability of dependable and reasonably priced sensors. These sensors make it 

possible to gather data from the real world, which is then transferred to and analyzed in 

the digital domain. AI and NLP. Due to the developments in neural networks, IoT 

devices now feature natural language processing, which makes them appealing and 

useful for a wide range of uses, such as conversational AI assistants and digital personal 

assistants. IoT has evolved from the convergence of wireless technologies, 

microelectromechanical systems and microservices. 

All these advancements have facilitated seamless connectivity and data exchange 

between devices and the cloud. What is the history and future outlook of IoT? Kevin 

Ashton, co-founder of the Auto-ID Center at the Massachusetts Institute of Technology 

(MIT), first mentioned the internet of things in a presentation he made in 1999 to Procter 

& Gamble (P&G). Wanting to bring radio frequency ID to the attention of P&G's senior 

management, Ashton called his presentation "Internet of Things" to incorporate the cool 

new trend of 1999: the internet. MIT professor Neil Gershenfeld's book, When Things 

Start to Think, also appeared in 1999. Although the book didn't use the exact term, it 

provided a clear vision of where IoT was headed. IoT has evolved from the convergence 

of wireless technologies, microelectromechanical systems, microservices and the 

internet. This convergence helped tear down the silos between operational technology 

and information technology, enabling unstructured machine-generated data to be 

analyzed for insights to drive improvements. 

Although Ashton was the first to mention IoT, the idea of connected devices has 

been around since the 1970s, under the monikers embedded internet and pervasive 

computing. The first internet appliance, for example, was a Coke machine at Carnegie 

Mellon University in the early 1980s. This is the world of the Internet of Things (IOT). 

Internet of things common definition is defining as: Internet of things (IOT) is a network 

of physical objects. The internet is not only a network of computers, but it has evolved 

into a network of device of all type and sizes vehicles, smart phones, home appliances, 

toys, cameras, medical instruments and industrial systems, animals, people, buildings, 

all connected ,all communicating & sharing information based on stipulated protocols 

in order to achieve smart reorganizations, positioning, tracing, safe & control & even 

personal real time online monitoring , online upgrade, process control & administration 

We define IOT into three categories as below. Easy accessibility. IoT provides easy 
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access to information from anywhere at any time on any device. For example, IoT 

enhances the accessibility of information by providing real-time data and insights, 

intuitive interfaces and proactive alerts. Improves communication. IoT improves 

communication between connected electronic devices. It achieves this by enabling 

efficient data exchange, extending network reach, conserving energy and prioritizing 

critical communications. For example, if a motion sensor in a smart home ecosystem 

detects activity at the front door, it triggers a communication alert with the smart 

lighting system to turn on the outdoor lights. Saves time and money. 

IoT enables the transfer of data packets over a connected network, which can save 

time and money. Predictive maintenance in industrial settings is another good example 

of this. IoT sensors installed on machinery continuously monitor parameters such as 

temperature, vibration and operating conditions in real-time. Data gathered from these 

sensors is analyzed using machine learning algorithms to detect patterns that show 

potential flaws or degradation in performance which helps in saving both time and 

money. Optimizes supply chain. IoT data can be used to optimize supply chain and 

inventory management processes, enabling manufacturers to reduce costs and enhance 

customer satisfaction. By tracking goods and materials in real-time, manufacturers can 

keep track of low stock, reduce excess inventory and streamline logistics operations. 

Improves efficiency. 

IoT analyzes data at the edge, reducing the amount of data that needs to be sent to the 

cloud. Edge computing enables physical devices to communicate more efficiently by 

processing data locally and exchanging only relevant information with other devices or 

cloud services. Provides automation. IoT automates tasks to improve the quality of a 

business's services and reduces the need for human intervention. For example, in 

agriculture, IoT-enabled irrigation systems can automatically adjust watering schedules 

based on soil moisture levels, weather forecasts and crop requirements. Improves 

customer experience. IoT enables the development of personalized products and 

services tailored to individual preferences and needs. Smart home devices, wearable 

technology and personalized recommendations in retail are examples of how IoT 

enhances the customer experience. Provides flexibility. IoT options can be scaled 

according to changing needs of a business. Whether it's adding new devices, expanding 

operations or integrating with existing systems, IoT provides the flexibility to scale and 

evolve with business requirements. Enables better business decisions. IoT generates 
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vast amounts of data that can be analyzed to gain valuable insights into operations, 

consumer behavior and market trends. By harnessing and analyzing big data, businesses 

can make data-driven decisions, optimize processes and identify new revenue 

opportunities. 

Internet of Things is refer to the general idea of things, especially everyday 

objects, that are readable, recognisable, locatable, addressable through information 

sensing device and/or controllable via the Internet, irrespective of the communication 

means (whether via RFID, wireless LAN, wide area networks, or other means). 

Everyday objects include not only the electronic devices we encounter or the products 

of higher technological development such as vehicles and equipment but things that we 

do not ordinarily think of as electronic at all - such as food , clothing ,chair, animal, 

tree, water etc. 

The Internet of Things is not a single technology, but it is a mixture of different 

hardware & software technology. The Internet of Things provides solutions based on 

the integration of information technology, which refers to hardware and software used 

to store, retrieve, and process data and communications technology which includes 

electronic systems used for communication between individuals or groups. There is a 

heterogeneous mix of communication technologies, which need to be adapted in order 

to address the needs of IoT applications such as energy efficiency, speed, security, and 

reliability. 

IoT enables the transfer of data packets over a connected network, which can 

save time and money. Predictive maintenance in industrial settings is another good 

example of this. IoT sensors installed on machinery continuously monitor parameters 

such as temperature, vibration and operating conditions in real-time. Data gathered from 

these sensors is analyzed using machine learning algorithms to detect patterns that show 

potential flaws or degradation in performance which helps in saving both time and 

money. Optimizes supply chain. IoT data can be used to optimize supply chain and 

inventory management processes, enabling manufacturers to reduce costs and enhance 

customer satisfaction. By tracking goods and materials in real-time, manufacturers can 

keep track of low stock, reduce excess inventory and streamline logistics operations. 

Improves efficiency. 
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6.2 ENABLING TECHNOLOGIES FOR IOT 

Internet of things (IoT) is a global infrastructure for the information society, enabling 

advanced services by interconnecting (physical and virtual) things based on existing 

and evolving interoperable information and communication technologies. With the 

Internet of Things the communication is extended via Internet to all the things that 

surround us. These are considered as being the enabling technologies that make 

“Internet of Things” applications possible. Enabling technologies for the Internet of 

Things are considered in and can be grouped into three categories: technologies that 

enable “things” to acquire contextual information, technologies that enable “things” to 

process contextual information, and technologies to improve security and privacy. The 

first two categories can be jointly understood as functional building blocks required 

building “intelligence” into “things”, which are indeed the features that differentiate the 

IoT from the usual Internet. The third category is not a functional but rather a de facto 

requirement, without which the penetration of the IoT would be severely reduced. 

The Internet of Things is not a single technology, but it is a mixture of different 

hardware & software technology. The Internet of Things provides solutions based on 

the integration of information technology, which refers to hardware and software used 

to store, retrieve, and process data and communications technology which includes 

electronic systems used for communication between individuals or groups. There is a 

heterogeneous mix of communication technologies, which need to be adapted in order 

to address the needs of IoT applications such as energy efficiency, speed, security, and 

reliability. In this context, it is possible that the level of diversity will be scaled to a 

number a manageable connectivity technologies that address the needs of the IoT 

applications, are adopted by the market, they have already proved to be serviceable, 

supported by a strong technology alliance. Examples of standards in these categories 

include wired and wireless technologies like Ethernet, WI-FI, Bluetooth, ZigBee, GSM, 

and GPRS. [1, 2] The key enabling technologies for the Internet of Things is presented 

in Figure. 
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6.3 CHARACTERISTICS 

The fundamental characteristics of the IoT are as follows 

Interconnectivity: 

With regard to the IoT, anything can be interconnected with the global information and 

communication infrastructure. 

Things-related services: The IoT is capable of providing thing-related services within 

the constraints of things, such as privacy protection and semantic consistency between 

physical things and their associated virtual things. In order to provide thing-related 

services within the constraints of things, both the technologies in physical world and 

information world will change. 

Heterogeneity: The devices in the IoT are heterogeneous as based on different 

hardware platforms and networks. They can interact with other devices or service 

platforms through different networks. 

Dynamic changes: The state of devices change dynamically, e.g., sleeping and waking 

up, connected and/or disconnected as well as the context of devices including location 

and speed. Moreover, the number of devices can change dynamically. 

Enormous scale: The number of devices that need to be managed and that 

communicate with each other will be at least an order of magnitude larger than the 

devices connected to the current Internet. Even more critical will be the management of 

the data generated and their interpretation for application purposes. This relates to 

semantics of data, as well as efficient data handling. 

Safety: As we gain benefits from the IoT, we must not forget about safety. As both the 

creators and recipients of the IoT, we must design for safety. This includes the safety of 

our personal data and the safety of our physical well-being. Securing the endpoints, the 

networks, and the data moving across all of it means creating a security paradigm that 

will scale. 

Connectivity: Connectivity enables network accessibility and compatibility. 

Accessibility is getting on a network while compatibility provides the common ability 

to consume and produce data. 
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6.4 IOT ARCHITECTURE 

IOT architecture consists of different layers of technologies supporting IOT. It serves 

to illustrate how various technologies relate to each other and to communicate the 

scalability, modularity and configuration of IOT deployments in different scenarios. 

Figure shows detailed architecture of IOT. The functionality of each layer is described 

below. smart device / sensor layer: The lowest layer is made up of smart objects 

integrated with sensors. The sensors enable the interconnection of the physical and 

digital worlds allowing real-time information to be collected and processed. There are 

various types of sensors for different purposes. The sensors have the capacity to take 

measurements such as temperature, air quality, speed, humidity, pressure, flow, 

movement and electricity etc. In some cases, they may also have a degree of memory, 

enabling them to record a certain number of measurements. A sensor can measure the 

physical property and convert it into signal that can be understood by an instrument. 

IOT architecture consists of different layers of technologies supporting IOT. It serves 

to illustrate how various technologies relate to each other and to communicate the 

scalability, modularity and configuration of IOT deployments in different scenarios. 

Figure shows detailed architecture of IOT. 

 

Fig 6.2 IOT Architecture 

Sensors are grouped according to their unique purpose such as environmental sensors, 

body sensors, home appliance sensors and vehicle telematics sensors, etc. Most sensors 
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require connectivity to the sensor gateways. This can be in the form of a Local Area 

Network (LAN) such as Ethernet and Wi-Fi connections or Personal Area Network 

(PAN) such as ZigBee, Bluetooth and Ultra Wideband (UWB). For sensors that do not 

require connectivity to sensor aggregators, their connectivity to backend 

servers/applications can be provided using Wide Area Network (WAN) such as GSM, 

GPRS and LTE. Sensors that use low power and low data rate connectivity, they 

typically form networks commonly known as wireless sensor networks (WSNs). WSNs 

are gaining popularity as they can accommodate far more sensor nodes while retaining 

adequate battery life and covering large areas. IOT architecture consists of different 

layers of technologies supporting IOT. 

It serves to illustrate how various technologies relate to each other and to 

communicate the scalability, modularity and configuration of IOT deployments in 

different scenarios. Figure shows detailed architecture of IOT. The functionality of each 

layer is described below. smart device / sensor layer: The lowest layer is made up of 

smart objects integrated with sensors. The sensors enable the interconnection of the 

physical and digital worlds allowing real-time information to be collected and 

processed. There are various types of sensors for different purposes. The sensors have 

the capacity to take measurements such as temperature, air quality, speed, humidity, 

pressure, flow, movement and electricity etc. In some cases, they may also have a 

degree of memory, enabling them to record a certain number of measurements. A sensor 

can measure the physical property and convert it into signal that can be understood by 

an instrument. IOT architecture consists of different layers of technologies supporting 

IOT. It serves to illustrate how various technologies relate to each other and to 

communicate the scalability, modularity and configuration of IOT deployments in 

different scenarios. Figure shows detailed architecture of IOT. The Internet of Things 

concept refers to uniquely identifiable things with their virtual representations in an 

Internet-like structure and IoT solutions comprising a number of components such as : 

Module for interaction with local IoT devices. This module is responsible for 

acquisition of observations and their forwarding to remote servers for analysis and 

permanent storage. Module for local analysis and processing of observations acquired 

by IoT devices. Module for interaction with remote IoT devices, directly over the 

Internet. This module is responsible for acquisition of observations and their forwarding 

to remote servers for analysis and permanent storage. Module for application specific 
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data analysis and processing. This module is running on an application server serving 

all clients. 

Gateways and Networks 

Massive volume of data will be produced by these tiny sensors and this requires a robust 

and high performance wired or wireless network infrastructure as a transport medium. 

Current networks, often tied with very different protocols, have been used to support 

machine-to-machine (M2M) networks and their applications. With demand needed to 

serve a wider range of IOT services and applications such as high speed transactional 

services, context-aware applications, etc., multiple networks with various technologies 

and access protocols are needed to work with each other in a heterogeneous 

configuration. These networks can be in the form of a private, public or hybrid models 

and are built to support the communication requirements for latency, bandwidth or 

security. Various gateways (microcontroller, microprocessor...) & gateway networks 

(WI-FI, GSM, GPRS…) are shown in figure. 

Management Service Layer 

The management service renders the processing of information possible through 

analytics, security controls, process modelling and management of devices. 

One of the important features of the management service layer is the business and 

process rule engines. IOT brings connection and interaction of objects and systems 

together providing information in the form of events or contextual data such as 

temperature of goods, current location and traffic data. Some of these events require 

filtering or routing to post processing systems such as capturing of periodic sensory 

data, while others require response to the immediate situations such as reacting to 

emergencies on patient’s health conditions. The rule engines support the formulation of 

decision logics and trigger interactive and automated processes to enable a more 

responsive IOT system. 

In the area of analytics, various analytics tools are used to extract relevant 

information from massive amount of raw data and to be processed at a much faster rate. 

Analytics such as in memory analytics allows large volumes of data to be cached in 

random access memory (RAM) rather than stored in physical disks. In-memory 

analytics reduces data query time and augments the speed of decision making. 

Streaming analytics is another form of analytics where analysis of data, considered as 
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data-in-motion, is required to be carried out in real time so that decisions can be made 

in a matter of seconds. 

Data management is the ability to manage data information flow. With data 

management in the management service layer, information can be accessed, integrated 

and controlled. Higher layer applications can be shielded from the need to process 

unnecessary data and reduce the risk of privacy disclosure of the data source. Data 

filtering techniques such as data anonymisation, data integration and data 

synchronization, are used to hide the details of the information while providing only 

essential information that is usable for the relevant applications. With the use of data 

abstraction, information can be extracted to provide a common business view of data to 

gain greater agility and reuse across domains. Security must be enforced across the 

whole dimension of the IOT architecture right from the smart object layer all the way 

to the application layer. Security of the system prevents system hacking and 

compromises by unauthorized personnel, thus reducing the possibility of risks. 

Application Layer 

The IoT application covers “smart” environments/spaces in domains such as: 

Transportation, Building, City, Lifestyle, Retail, Agriculture, Factory, Supply chain, 

Emergency, Healthcare, User interaction, Culture and tourism, Environment and 

Energy. 

6.5 IOT FUNCTIONAL VIEW 

The Internet of Things concept refers to uniquely identifiable things with their virtual 

representations in an Internet-like structure and IoT solutions comprising a number of 

components such as : Module for interaction with local IoT devices. This module is 

responsible for acquisition of observations and their forwarding to remote servers for 

analysis and permanent storage. Module for local analysis and processing of 

observations acquired by IoT devices. Module for interaction with remote IoT devices, 

directly over the Internet. This module is responsible for acquisition of observations 

and their forwarding to remote servers for analysis and permanent storage. Module for 

application specific data analysis and processing. This module is running on an 

application server serving all clients. 

It is taking requests from mobile and web clients and relevant IoT observations 

as input, executes appropriate data processing algorithms and generates output in terms 

of knowledge that is later presented to users. User interface (web or mobile): visual 
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representation of measurements in a given context (for example on a map) and 

interaction with the user, i.e. definition of user queries. The Internet of Things concept 

refers to uniquely identifiable things with their virtual representations in an Internet- 

like structure and IoT solutions comprising a number of components such as : Module 

for interaction with local IoT devices. This module is responsible for acquisition of 

observations and their forwarding to remote servers for analysis and permanent storage. 

Module for local analysis and processing of observations acquired by IoT devices. 

Module for interaction with remote IoT devices, directly over the Internet. This module 

is responsible for acquisition of observations and their forwarding to remote servers for 

analysis and permanent storage. Module for application specific data analysis and 

processing. 

The Internet of Things concept refers to uniquely identifiable things with their 

virtual representations in an Internet-like structure and IoT solutions comprising a 

number of components such as : Module for interaction with local IoT devices. This 

module is responsible for acquisition of observations and their forwarding to remote 

servers for analysis and permanent storage. Module for local analysis and processing of 

observations acquired by IoT devices. This module is responsible for acquisition of 

observations and their forwarding to remote servers for analysis and permanent storage. 

Module for application specific data analysis and processing. This module is running 

on an application server serving all clients. It is taking requests from mobile and web 

clients and relevant IoT observations as input, executes appropriate data processing 

algorithms and generates output in terms of knowledge that is later presented to users. 

User interface (web or mobile): visual representation of measurements in a given 

context (for example on a map) and interaction with the user, i.e. definition of user 

queries. 

The Internet of Things concept refers to uniquely identifiable things with their 

virtual representations in an Internet-like structure and IoT solutions comprising a 

number of components such as : Module for interaction with local IoT devices. This 

module is responsible for acquisition of observations and their forwarding to remote 

servers for analysis and permanent storage. Module for local analysis and processing of 

observations acquired by IoT devices. This module is responsible for acquisition of 

observations and their forwarding to remote servers for analysis and permanent storage. 

Module for application specific data analysis and processing. This module is running 

on an application server serving all clients. 
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6.6 FUTURE TECHNOLOGICAL DEVELOPMENTS FOR IOT. 

The development of enabling technologies such as semiconductor electronics, 

communications, sensors, smart phones, embedded systems, cloud networking, 

network virtualization and software will be essential to allow physical devices to 

operate in changing environments & to be connected all the time everywhere. 
 

 

Fig 6.3: Technological Development IOT 

The Internet of Things concept refers to uniquely identifiable things with their virtual 

representations in an Internet-like structure and IoT solutions comprising a number of 

components such as : Module for interaction with local IoT devices. This module is 

responsible for acquisition of observations and their forwarding to remote servers for 

analysis and permanent storage. Module for local analysis and processing of 

observations acquired by IoT devices. This module is responsible for acquisition of 

observations and their forwarding to remote servers for analysis and permanent storage. 

Module for application specific data analysis and processing. This module is running 

on an application server serving all clients. It is taking requests from mobile and web 

clients and relevant IoT observations as input, executes appropriate data processing 

algorithms and generates output in terms of knowledge that is later presented to users. 

User interface (web or mobile): visual representation of measurements in a given 
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CHAPTER 7 

SOFTWARE USED 

7.1 PROGRAMMING ARDUINO 

Once arduino IDE is installed on the computer, connect the board with computer 

using USB cable. Now open the arduino IDE and choose the correct board by 

selecting Tools>Boards>Arduino/Genuino Uno, and choose the correct Port by 

selecting Tools>Port. Arduino Uno is programmed using Arduino programming 

language based on Wiring. To get it started with Arduino Uno board and blink the 

built-in LED, load the example code by selecting Files>Examples>Basics>Blink. 

Once the example code (also shown below) is loaded into your IDE, click on the 

‘upload’ button given on the top bar. Once the upload is finished, you should see the 

Arduino’s built-in LED blinking. Below is the example code for blinking: 

Tools>Boards>Arduino/Genuino Uno, and choose the correct Port by selecting 

Tools>Port. Arduino Uno is programmed using Arduino programming language 

based on Wiring. 

7.2 ARDUINO – INSTALLATION 

After learning about the main parts of the Arduino UNO board, we are ready to learn 

how to set up the Arduino IDE. Once we learn this, we will be ready to upload our 

program on the Arduino board. 

In this section, we will learn in easy steps, how to set up the Arduino IDE on our 

computer and prepare the board to receive the program via USB cable. 

Step 1: First you must have your Arduino board (you can choose your favorite board) 

and a USB cable. In case you use Arduino UNO, Arduino Duemilanove, Nano, 

Arduino Mega 2560, or Diecimila, you will need a standard USB cable (A plug to B 

plug), the kind you would connect to a USB printer as shown in the following image. 

 

Fig 7.1: USB Printer 
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In case you use Arduino Nano, you will need an A to Mini-B cable instead as shown 

in the following image 

 

 

Fig 7.2: Mini Cable 

Step 2: Download Arduino IDE Software. 

You can get different versions of Arduino IDE from the Download page on the 

Arduino Official website. You must select your software, which is compatible with 

your operating system (Windows, IOS, or Linux). After your file download is 

complete, unzip the file. 

 

 
Fig 7.3 : Arduino Ide Software 

Step 3: Power up your board. 

The Arduino Uno, Mega, Duemilanove and Arduino Nano automatically draw power 

from either, the USB connection to the computer or an external power supply. If you 

are using an Arduino Diecimila, you have to make sure that the board is configured 

to draw power from the USB connection. The power source is selected with a jumper, 
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a small piece of plastic that fits onto two of the three pins between the USB and 

power jacks. Check that it is on the two pins closest to the USB port. 

Connect the Arduino board to your computer using the USB cable. The green power 

LED (labeled PWR) should glow. 

Step 4: Launch Arduino IDE. 

After your Arduino IDE software is downloaded, you need to unzip the folder. Inside 

the folder, you can find the application icon with an infinity label (application.exe). 

Double click the icon to start the IDE 
 

Fig 7.4: Arduino Folder 

Step 5: Open your first project. 

Once the software starts, you have two options: 

Create a new project. 

Open an existing project example. 
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To create a new project, select File --> New 
 

Fig 7.5: Open Your Project 

To open an existing project example, select File -> Example -> Basics -> Blink. 

 

Fig 7.6 Basic File Open 

Here, we are selecting just one of the examples with the name Blink. It turns the LED 

on and off with some time delay. You can select any other example from the list. 
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Step 6: Select your Arduino board. 

To avoid any error while uploading your program to the board, you must select the 

correct Arduino board name, which matches with the board connected to your 

computer. 

Go to Tools -> Board and select your board. 
 

Fig 7.7: Arduino Board 

Here, we have selected Arduino Uno board according to our tutorial, but you must 

select the name matching the board that you are using. 
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Step 7: Select your serial port. 

Select the serial device of the Arduino board. Go to Tools -> Serial Port menu. This 

is likely to be COM3 or higher (COM1 and COM2 are usually reserved for hardware 

serial ports). To find out, you can disconnect your Arduino board and re-open the 

menu, the entry that disappears should be of the Arduino board. Reconnect the board 

and select that serial port. 
 

 
Fig 7.8: Serial Port 

Step 8: Upload the program to your board. 

Before explaining how we can upload our program to the board, we must 

demonstrate the function of each symbol appearing in the Arduino IDE toolbar 

A- Used to check if there is any compilation error. 

B- Used to upload a program to the Arduino board. 

C- Shortcut used to create a new sketch. 
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D- Used to directly open one of the example sketch. 

E- Used to save your sketch. 

F- Serial monitor used to receive serial data from the board and send the serial data 

to the board. 

 

 

Now, simply click the "Upload" button in the environment. Wait a few seconds; you 

will see the RX and TX LEDs on the board, flashing. If the upload is successful, the 

message "Done uploading" will appear in the status bar. 

Note: If you have an Arduino Mini, NG, or other board, you need to press the reset 

button physically on the board, immediately before clicking the upload button on the 

Arduino Software. 

7.3 ARDUINO – PROGRAM STRUCTURE 

we will study in depth, the Arduino program structure and we will learn more new 

terminologies used in the Arduino world. The Arduino software is open-source. The 

source code for the Java environment is released under the GPL and the C/C++ 

microcontroller libraries are under the LGPL. 

Sketch: The first new terminology is the Arduino program called “sketch”. 

Structure Arduino programs can be divided in three main parts: Structure, Values 

(variables and constants), and Functions. In this tutorial, we will learn about the 

Arduino software program, step by step, and how we can write the program without 

any syntax or compilation error. Let us start with the Structure. Software structure 

consist of two main functions: 
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Setup( ) function 

Loop( ) function 
 

 

 

PURPOSE: The setup() function is called when a sketch starts. Use it to initialize 

the variables, pin modes, start using libraries, etc. The setup function will only run 

once, after each power up or reset of the Arduino board. 

INPUT: - 

OUTPUT:  - 

RETURN: 
 

PURPOSE: After creating a setup() function, which initializes and sets the initial 

values, the loop() function does precisely what its name suggests, and loops 

consecutively, allowing your program to change and respond. Use it to actively 

control the Arduino board. 

INPUT: 

OUTPUT: 

RETURN: 
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CHAPTER - 8 

RESULTS 

Internet of Things has gained its wide popularity in recent days due to its various 

streams of applications which has paved way for smooth, safe and easier mode of 

living style for human beings. Though, several techniques is existing for the same, 

yet sewage cleaning is one major concern and a challenge always. This paper thus 

put forth a new proposed system which is micro controller based application of 

sewage workers health monitoring systems using IOT. This device is designed 

keeping in mind, the measurement of necessary parameters, which needs to be 

monitored for unhindered safety of the workers. The device finds major application 

in household sewage systems, municipal manholes and sewage, sewer, deep well, 

gutters and drains etc. 

However, the places where toxic gases or fumes are present should never be 

handled by human workers directly. In country like India where sewage is mostly 

cleaned by humans, which make this device useful around India. The proposed 

methodology helps to prevent the sudden accident of workers and also helps to keep 

the society clean. The smart safety device is cost wise less and fast in accessing the 

WSN and transfer the information to both the concerned department and emergency 

department. The proposed device helps the worker at a basic level of knowledge to 

understand the gas level and his pulse rate. The smart device can be implemented 

and used across the world and also helps to monitor the overflow of the sewage water. 

 
 

 

CONCLUSION 

A Smart Safety Monitoring System for Sewage Workers with Two-Way 

Communication is an innovative approach designed to enhance safety and 

productivity in hazardous work environments like sewage systems. The system 

involves multiple components that track real-time data, such as environmental 
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conditions, worker status, and safety equipment, with the added capability for 

workers to communicate with supervisors or emergency responders. The Smart 

Safety Monitoring System for Sewage Workers with Two-Way Communication 

offers several advantages, making it a highly beneficial solution for enhancing 

safety and efficiency in hazardous environments. Here are the key advantages: 

1. Enhanced Worker Safety 

Real-time Hazard Detection: Continuous monitoring for hazardous gases (like methane 

or hydrogen sulfide temperature extremes, and low oxygen levels provides early 

warnings, reducing the risk of exposure to dangerous conditions. 

Health Monitoring: Wearable devices track vital signs like heart rate, body temperature, 

and fatigue levels, alerting supervisors if a worker shows signs of distress or health 

risks. Immediate Emergency Alerts: The system can trigger alarms and notify 

emergency responders instantly in case of a safety breach, ensuring a fast and effective 

response to incidents. 

2. Improved Communication 

Two-Way Communication: Workers can directly communicate with supervisors or 

emergency teams in real-time, enabling them to report issues or request assistance 

without delay. 

Remote Supervision: Supervisors can monitor workers remotely, ensuring that safety 

protocols are followed, and can provide immediate instructions or guidance if 

necessary. Multiple Channels: Communication can happen via voice, text, or video, 

providing flexibility depending on the situation or urgency. 

APPLICATIONS 

1. Sewage and Wastewater Treatment Plants 

Hazardous Gas Detection: Sewage workers are at risk of exposure to toxic gases like 

methane, hydrogen sulfide, and ammonia. The system continuously monitors these 

gases and alerts workers to potential dangers, enabling quick evacuation if necessary. 

Confined Space Monitoring: Sewage systems often involve working in confined 

spaces, where oxygen levels and air quality may fluctuate. The system tracks these 

environmental parameters and sends alerts if conditions become unsafe. 
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Real-Time Communication: Workers can communicate directly with supervisors in 

real-time, ensuring immediate help in emergencies or when advice is needed about a 

specific task or situation. 

2. Construction and Underground Utilities 

Underground Safety Monitoring: In construction sites or utility work, workers often 

operate in tunnels, trenches, and underground settings where environmental 

conditions can change rapidly. The system ensures air quality is monitored, and 

workers' health is checked, reducing the risks of asphyxiation, accidents, or health 

problems. 

Worker Location Tracking: In vast and complex underground networks, real-time 

tracking ensures that workers’ locations are always known, which is critical in case 

of an emergency or a need for evacuation. 

FUTURE SCOPE 

Integration with Artificial Intelligence (AI) and Machine Learning (ML) Predictive 

Analytics: Future systems will leverage AI and machine learning to analyze the vast 

amounts of data collected from sensors, wearables, and environmental monitors. This 

data can be used to predict potential safety hazards before they occur, based on trends 

and patterns. 

AI-Based Decision Making: AI algorithms can help supervisors make real-time 

decisions, such as identifying when a worker may be at risk of health problems (e.g., 

fatigue, dehydration) and suggesting preventive measures automatically. 

Risk Assessment: Machine learning can assess risk factors based on historical 

data, weather conditions, and other variables, allowing the system to predict and 

mitigate dangers more effectively. Integration with Augmented Reality (AR) and 

Virtual Reality (VR) AR for On-Site Assistance: AR glasses or helmets could provide 

real-time visual instructions to workers, guiding them through complex procedures 

and offering real-time. 
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APPENDIX 

Appendix-1: Introduction 

1. Overview of the Smart Safety Monitoring System for sewage 

workers. 

2. Importance of ensuring worker safety in hazardous 

environments. 

Appendix-2: System Components 

1. List of hardware and software components. 

2. Sensors (Gas, Temperature, Humidity, etc.). 

3. Microcontrollers and Communication Modules (GSM, Wi-Fi, 

Bluetooth). 

4. Protective Gear Integration. 

Appendix-3: Working Principle 

1. Explanation of the system's working mechanism. 

2. Detection of hazardous gases, temperature variations, and 

humidity. 

3. Communication and alert mechanisms. 

Appendix-4: Circuit Diagram & Block Diagram 

1. Detailed circuit diagram representation. 

2. Block diagram explaining the system’s connectivity and flow of 

information. 

Appendix-5: Two-Way Communication Feature 

1. Use of GSM/Wi-Fi/Bluetooth for worker communication. 

2. Features enabling distress calls and emergency responses. 
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